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To install and use Quicken 2007 products you will need the 
following: 

•	 IBM or compatible Pentium II 300 (Pentium III 450 
recommended) with 64 MB RAM (128 MB RAM 
recommended)

•	 Windows 2000 / XP (Windows XP recommended)

•	 MS Excel 2002 or higher required to start the FIDO 
Superannuation Calculator (H&B and Personal Plus only)

•	 185 MB of disk space for Quicken installation

•	 Internet Explorer 6.0 (provided on CD-ROM, requires  
55 MB) 

•	 SVGA video with 256 colours

•	 800 x 600 resolution (1024 x 768 resolution 
recommended) 

•	 Works with any printer supported by Windows 2000 / XP 

•	 Double speed CD-ROM (6X or higher recommended)

•	 All online features/services (such as online investment 
tracking) require Internet access with at least a 
28.8 Kbps modem (High speed Internet access 
recommended) 

	 Latest service packs for Windows and Internet Explorer 
recommended.

Existing Quicken 
users

How to upgrade 
your data file

System Requirements
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Your Installed Quicken Products

Quicken 2007 will uninstall any previous Quicken product 
installed on your PC. The data files will remain in the same 
location they were before the installation of Quicken 2007.

Changes to Cash Flow Forecasts

After upgrading, Quicken may not be able to recognise 
cash flow scenarios that you have saved in a previous 
version. If this occurs, you will need to re-create the forecast 
following the upgrade. To do this, select Cash Flow Forecast 
from the Planning dropdown menu, then select accounts 
and dates from the Options menu to customise the 
scenario. Select Manage Scenarios from the Options menu.  
Click New and enter a new scenario name, then click OK to 
save the new scenario.

Updating your stocks from Quicken Version 8 
or below

Quicken includes new features for tracking your investments, 
such as the ability to download stock prices from different 
exchanges (Australia, NZ, US). If you have upgraded from 
Version 8, the exchange and asset class for each security will be 
set to your default country. You must specify the asset class and 
exchange for each security once you have upgraded to Quicken 
2007. To do this, select Security List from the Investment 
dropdown menu. Highlight the individual security and then 
select Edit from the menu. You will then be able to assign an 
exchange and asset class from the relevant dropdown lists. If a 
‘Symbol Change Affects Price History’ message appears, simply 
click OK to copy the quotes.

Changes to Budgeting

Many features of Quicken have been updated in response to 
feedback from Quicken users. The budgeting feature and user 
interface has been customised to make it easier to use. As a 
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Before you install –  
changes to Quicken 
you should note

result, you may notice budgets no longer use a spreadsheet 
format or show projected balances in Quicken 2007.

Category groups

If you created your own groups for categories in a previous 
version, they may not be maintained during the upgrade to 
Quicken 2007. In order to recreate these groups and reassign 
them, select Category List from the Tools menu, then select 
the relevant category from the list and click Edit. Select the 
group dropdown menu and click New. Enter a new group 
name and click OK. Continue to create new group names as 
necessary and assign them to relevant categories.

Billminder is no longer available in Quicken

If you have upgraded from Quicken 2004 or below, you will 
notice that we have removed Billminder from Quicken. This 
is in response to customer feedback, which advises us that 
Billminder is not a valued feature.

Upgrading a data file from Quicken 2004 (or 
below)

Any savings accounts that have been created in Quicken 2004 
(or below) do not have an Account Location field. However, 
in Quicken 2007 the Account Location field cannot be 
empty. Therefore, after upgrading from Quicken 2004 (or below) 
to Quicken 2007, savings accounts will have Spending placed 
in the Account Location field. 

The new In / Out / What’s left feature in Quicken 
2007 allows users to immediately see where their money is 
going using various charts and tables. This feature displays 
information using the savings accounts that have Spending 
located in the Account Location field.

If you are upgrading from Quicken 2004 (or below) to Quicken 
2007 and have savings accounts setup, you should change the 
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Account Location field from Spending to Saving.  
This ensures the In / Out / What’s left feature displays 
the correct information.

To change the Account Location field, place the cursor 
over the account name in the at-a-glance bar, right click on the 
account name and select Edit Account. Quicken displays the 
Account details window. Change the Account Location 
field from Spending to Saving.

If you upgraded a data file that contained a 
linked account

The Quicken 2007 Investment Activity Report will report on 
all transactions from the linked accounts. New transactions 
entered in the linked accounts in Quicken 2007 will continue to 
appear in the Investment Activity Report.

Upgrading from CashBook 2003 or CashBook 
2004

The Itemised Category Report in Quicken 2007 does not 
include account balances forward by default. To include 
account balances forward, click Customise Report, choose 
the Advanced Tab, and choose Include All from the 
Transfers drop-down menu.

If you have at any stage had ‘return of capital’ transactions 
entered in an investment account that has a linked bank 
account, the Itemised Category report will not add the return 
of capital transactions to the total.

Opening your original data file after upgrading 
from Quicken 2005 or Quicken 2006

When you upgrade to Quicken 2007, a backup of your original 
data file will automatically be placed in a folder called Q05Files 
in your Quicken directory. Use this backup to view your original 

file in your previous version. You may use the File>Restore or 
File>Open function.

Opening your original data file after upgrading 
from Quicken 2002 or CashBook 2003 or 
Quicken 2004

When you upgrade to Quicken 2007, a backup of your 
original data file will automatically be placed in a folder called 
UpgBkup in your Quicken directory. Use this backup to view 
your original file in your previous version. You may use the 
File>Restore or File>Open function.

Access permissions

If you encounter the error message “Installshield Error 
1608: Unable to create InstallDriver instance, unable to install”, 
you will need to change the DCOM file on your computer.

To do this;

a)	 Click the Microsoft® Windows® Start button, choose Run. 

b)	 Enter dcomcnfg in the Open field, and then click OK.

c)	 Click the Default Security tab, and then in the Default 
Access Permissions section, click Edit Default.

d)	 Make sure that Allow Access is selected, and then 
click OK. Try installing again. (If you receive the error 
message again, continue to step f.) 

e)	 If the issue continues to occur, install Quicken in Safe 
Mode, and then restart your computer. (If you receive 
the error message again, continue to step g.)

f )	 If the issue still persists, create a new Windows user 
account with administrator permissions.

	 Note: These steps apply to Microsoft® Windows® 2000 
and may vary for other Windows versions. Please refer to 
Windows Help for specific instructions for your version.

Before you install (cont)
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Before you install (cont)

g)	 Click Start button > Settings > Control Panel. Then 
double-click Users and Passwords.

h)	 Click the User tab, click Add User, and then follow the 
onscreen instructions to create a user account with 
administrative permissions.

i)	 Restart your computer and login with the new 
administrator account.

j)	 Attempt to install or uninstall the Quicken program 
again.

Other installation problems 

•	 Are you logged onto your PC as the Administrator?

•	 Have you shut down all applications?

•	� Is your anti-virus software blocking your installation  
of Quicken?

•	� Try installing Quicken in safe mode. For instructions on re-
starting your PC in safe mode, refer to your windows help. 
Once you have installed Quicken in safe mode, do not try 
to open it. Re-start your PC in normal mode and make sure 
you are connected to the internet. Open Quicken and enter 
your install key to Activate. If you do not have an internet 
connection, you will need to click Cancel on the messages 
that appear and then call Customer Support to Activate 
over the telephone.

•	� Still having problems? Check the Quicken on-line 
knowledge browser at http://www.quicken.com.au/
Support/FAQs.aspx and search the database for error 
message.

Check the upgrade 
path  
for your current 

Find your current version from the list below and check the upgrade path.  
If there is a tick in the row for your current version, then you can upgrade 
directly to Quicken 2007.  

If ‘via CashBook 2004’ appears in the row for your current version, then you 
must firstly upgrade your data file to CashBook 2004 and then to Quicken 2007.  
If ‘via Personal Plus 2006’ appears in the row for your current version, then you 
must firstly upgrade your data file to Personal Plus 2006 and then to Quicken 
2007. You must do this before installing Quicken 2007. Follow the upgrade 
instructions on the following pages carefully.

Your current version
Home & 

Business 2007
Quicken Personal 

Plus 2007

Quicken 
Personal      

2007

Personal Plus 2006 a a

Personal 2006 a a a

Home & Business 
2005/06

a

Personal Plus 2005 a a

Personal 2005 a a a

CashBook 2004† a

Personal Plus 2004 via Personal Plus 2006 via Personal Plus 2006

Personal 2004 via Personal Plus 2006 via Personal Plus 2006

CashBook 2003† a

Personal Plus SE 2002 via Personal Plus 2006 via Personal Plus 2006

Personal SE 2002 via Personal Plus 2006 via Personal Plus 2006

Personal Plus 2002 via Personal Plus 2006 via Personal Plus 2006

Personal 2002 via Personal Plus 2006 via Personal Plus 2006

CashBook v8 via CashBook  2004*

Personal Plus v8 via CashBook  2004* via CashBook  2004*

Personal v8 via CashBook  2004* via CashBook  2004*
via CashBook  

2004*

†	  Some CashBook features do not exist in Home & Business 2007.

*	� CashBook 2004 is provided on your Quicken 2007 CD. Click the Upgrade Software button from the 
Quicken 2007 Starter Kit which appears when you insert the installation CD in your CD drive.

Upgrade Software Located on CD

CashBook 2004 \\CV\CBTrial 
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Prepare your data 
file  
for upgrade

We strongly recommend that you do the following to protect 
your data and ensure its accuracy.

1. 	�Back up your data file

	� To do this, choose File menu > Backup. Choose the file 
you wish to back up and the location you wish to back it up 
to. For more information on how to back up, please refer 
to the User Guide (available on the Quicken CD) or Online 
Help for “Backing up your data”.

2. 	Validate your data file

	� Ensure the data file you are using is validated before 
upgrading your software. Validating a data file allows 
Quicken to verify its integrity. Choose File menu > File 
Operations and click Validate. Find and select the 
data file you wish to validate and click OK. You will need to 
repeat this process for every data file you wish to upgrade.

3. 	�Print a selection of Reports from the data 
file in your currently installed version

	� Print a record of all business Tax reports for previous 
periods (e.g. Tax Detail, BAS). You can use these Reports 
after upgrading to confirm the data which appears in the 
upgraded version is correct. Note: some reports in Quicken 
2007 have different default settings to what they were in 
earlier Quicken products. In some cases, these reports may 
require the user to customise the report to obtain the same 
figures. 

4. 	�Ensure ALL unapplied Adjustments/Credits 
are applied to an Invoice or deleted

5. 	�Delete all Scheduled Invoices and Payments 
(taking note of details)

6. 	Take note of your Quicken Settings/      
Preferences

	� Some of the settings within your data file will revert to 
the default settings of Quicken 2007. Make a note of your 
personal settings and preferences so you can apply these 
to your upgraded data file.

7. �	�Saved Reports will not be available after the 
conversion

	� We recommend that you print any Saved Reports from 
your current version beforehand, for your reference.

8. 	�ABN and Branch number will need to be  
re-entered in your data file after conversion

9. 	If you have customised templates

	� Customised Invoice and Estimate templates from your 
previous version will only convert directly to Quicken 
Home & Business if you install Home & Business in the same 
installation directory as your previous version of Quicken, 
once the previous version has been uninstalled.

10. If you have a linked investment account

	� If you upgrade a Quicken data file that contains a linked 
investment account, the Investment Activity Report in 
Quicken 2007 will always report on all transactions from 
both accounts. To avoid this from happening, you should 
un-link the accounts in your previous version prior to 
upgrading.
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Upgrading your data 
file 

	

Reminder! Before upgrading, have you:

	 • �Printed a selection of reports from your original Quicken 
program?

	 • �Created a backup of your original data file and validated 
it?

To upgrade from Quicken Personal v8 or Personal Plus v8 or 
CashBook v8 – continue reading this page.

To upgrade from a different version – start on page 16.

Upgrading from Quicken Personal v8 or 
Personal Plus v8 or CashBook v8

Quicken Personal v8 and Personal Plus v8 have now been 
sunsetted. In order to convert your data file to Quicken 2007, 
you need to step your data file up through CashBook 2004. 
CashBook 2004 Trial is available on the Quicken 2007 CD. 

Install CashBook 2004 Trial

1.	� Make sure that your current version of Quicken 
(Personal v8 or Personal Plus v8 or CashBook v8) is 
backed up on disk and your hard drive then close 
Quicken.

2.	� Insert your Quicken 2007 CD into your CD-ROM drive. 
The installation screen will automatically appear. If this 
does not happen, select Run from the Windows Start 
menu, then type d:\autorun.exe (where d is your CD-
ROM drive) and click OK.

3.	 From the menu, select Upgrade Software.

4.	 Click on Install CashBook 2004 Trial.

5.	 Click Yes when prompted to install CashBook 2004.

6.	 Click Next when the Welcome screen appears.

7.	� Choose where you would like to install CashBook 2004 
and click Next.	

Note: You should install CashBook 2004 in the same 
installation directory as your previous version (default 
location is c:\program files\quickenw).

8.	� A message will be displayed prompting you to uninstall 
your previous version of Quicken. Click Yes to uninstall 
your previous version of Quicken. This will not affect 
your existing Quicken data.

9.	� Follow the prompts to uninstall your previous version 
of Quicken.

10.	� Click No to All when prompted to remove all shared 
files.

11.	� When the uninstall process is complete, click OK.

12.	� Select Run from the Windows Start menu, then type d:\
autorun.exe (where d is your CD-ROM drive) and click OK

13.	� From the installation screen menu, select Upgrade 
Software, then click on Install CashBook 2004 
Trial

14.	 Follow the prompts to install CashBook 2004.

Note: You should install CashBook 2004 in the same 
installation directory as your previous version (default 
location is c:\program files\quickenw).

15.	� Restart your computer to complete the installation of 
CashBook 2004.

16.	� Launch CashBook 2004 and upgrade your data file by 
clicking OK when prompted. If you have more than one 
data file, each must be upgraded by selecting Open from 
the File menu and selecting the data file.

17.	� Once you have completed upgrading your data file/s to 
CashBook 2004, follow the instructions on page 17.
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Upgrading from Quicken Personal 
2002, Personal Plus 2002 (or 2002 SE), 
Personal 2004 or Personal Plus 2004

You need to upgrade your data file to Personal Plus 2006 first 
and then upgrade to Quicken 2007. 

1.	 Ensure you have completed the instructions in Prepare 
your data file for upgrade on page 12.

2.	 Download Personal Plus 2006 trial version from  
http://www.quicken.com.au/PersonalFinance/
PersonalPlus/trial06.aspx.

3.	 Install Personal Plus 2006 trial version with the 
installation key code that is displayed on the screen 
when you download the trial.

4.	 Activate Personal Plus 2006 trial version online with your 
customer ID and pin.

5.	 Launch Personal Plus 2006 and upgrade your data file.

6.	 Once you have completed upgrading your data file/s 
to Personal Plus 2006, follow the instructions on the 
following page.

Upgrading from CashBook 2003,  
CashBook 2004, Personal 2005, 
Personal Plus 2005, Personal 2006 or 
Personal Plus 2006

You may directly upgrade your data file to Quicken 2007.

Please Note: When you upgrade to Quicken 2007, a 
backup of your original file will automatically be placed 
in a folder in your Quicken directory. See page 8 for 
instructions. 

Follow the instructions below to upgrade your data file to  
Quicken 2007

1.	 Ensure you have completed the instructions in 
Prepare your data file for upgrade.

2.	 Make sure your current version of Quicken is closed.

3.	 Insert the Quicken 2007 CD into the CD-ROM drive. The 
installation screen will automatically appear. If this does 
not happen, select Run from the Windows Start menu. 
Type ‘d:\autorun.exe’ (where d is your CD-ROM drive) 
and click OK.

4.	 From the installation screen, select Install Quicken 
2007.

5.	 Click on Install Quicken Now to install the full 
version.

6.	 Click Next when the Welcome screen appears.

7.	 Read the Licence Agreement and if you agree to the 
terms, click Yes.

8.	 Select the type of installation and the Country version, 
then click Install Now.

Upgrading your data 
file  (cont) 
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Note: If you have an older Quicken installation (v2004 
or below) on your PC, you may receive a message 
requesting that you exit and uninstall before installing 
Quicken 2007. When you return to install Quicken 2007, 
you may be asked to Remove Shared Files? 
Select Yes to all

9.	 Select Yes to restart your computer, and click Finish

10.	 The first time you open Quicken 2007, you will 
be required to Activate by entering your Quicken 
Installation Key. This process will take place 
automatically over the Internet. If you do not have an 
Internet connection, you will need to click Cancel 
on the messages that appear and then call Customer 
Support to complete the process over the telephone.

11.	 The first time you open your data file in Quicken 2007, 
the upgrade process will begin. Read the upgrade 
message and click OK if your wish to continue. If you 
have a large file or if you have investment data, the 
upgrade may take several minutes.

12.	 Follow the prompts to set up your data file in Quicken 
2007, click Done when you have finished.

After you upgrade 

•	 Check your data in the upgraded version.  Run the 
same reports you ran before upgrading and compare 
them to confirm the data matches.  If your data does 
not match the previous version, try to identify where 
the problem is.  For example, it may relate specifically 
to categories or transactions.

•	 Check the Quicken settings and preferences against the 
settings you noted before upgrading your data file in 
Prepare your data file for upgrade.

•	 Explore Quicken’s many new features in What’s new 
in Quicken under the Help menu

•	 Backup your data file 

DO NOT OVERWRITE 
YOUR PREVIOUS 

BACKUP!

You may choose to back up your data file to a CD-ROM 
or other storage media. Make sure that you label each 
disk correctly and store it in a safe place in case you need 
them later. Do not overwrite this backup. (You can find 
instructions on backing up your data from your user guide 
which is available on the Quicken 2007 CD-ROM)
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New Quicken users
Before you install Quicken, you need to:

•	 Log on to your PC as the Administrator or have 
Administrator rights

•	 Close all programs

•	 Disconnect from the Internet

•	 Disable your anti-virus software and firewall

Once you have installed your Quicken product, you will 
need to re-enable your anti-virus software and firewall, then 
reconnect to the Internet so that you can activate your 
Quicken product online.

To install Quicken 2007:

1.	 Insert the Quicken 2007 CD into the CD-ROM drive.

	 If the installation screen does not start automatically, 
choose Start menu > Run from the Windows 
desktop. Type d:\autorun.exe where d is your CD-
ROM drive, and click OK.

2.	 Click Install Quicken and then Install Quicken 2007.

3.	 Follow the onscreen instructions to install Quicken.

4.	 You will find your IKC in the letter you received with 
your CD-ROM.

5.	 Reboot your PC to complete the Quicken installation

6.	 Double-click the Quicken icon on your desktop to 
open your 2007 Quicken product.

	 Start a new file, or browse the features of Quicken 
2007 using the sample file.

Activate your Quicken 2007 product

Once you have installed and opened your software, you will be 
prompted to activate your Quicken 2007 product. You need to 
enter you IKC to complete this.  You will find your IKC in the 
letter you received with your CD-ROM. You need an Internet 
connection to activate online.

How to install  
Quicken products
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Licence 
Agreement 

Licence Agreement 

THIS IS AN IMPORTANT 
DOCUMENT. PLEASE 
READ THIS CAREFULLY. 
This is a contract between Reckon Limited (ACN 003 348 730) (Reckon) and you. 
By using the Quicken® software supplied with this document, and the related 
user guides and materials (together the Software), you agree to be bound by 
the terms of this Licence. This Licence covers copies of the Software provided for 
evaluation or trial purposes, subscription versions and non-subscription or full 
versions of the Software. Some Licence provisions may not be applicable to you, 
depending on the particular version of the Software you have purchased or if you 
are using the Software for evaluation purposes. The defined terms and the rules of 
interpretation in this Licence are set out in clause 11.

Important: There are a number of technical features within the Software that 
may affect your ability to continue to use the Software. These are outlined in more 
detail in the terms of the Licence, but in summary:

•	 you are purchasing the right to use the Software, not to own it.

•	 if you have been provided with a Trial Version, you may only use the 
Software on a temporary basis to evaluate the Software’s functionality 
and suitability for your requirements.

•	 the Software may contain registration and activation processes to guard 
against illegal copying.

•	 to continue using the Software, those processes require you to verify 
your compliance with the terms under which you are licensed to 
use the software (for example: the number of computers on which 
the software is installed) and to permit continued reactivation of the 
Software from time to time. This involves, in all versions, periodically 
verifying your licence details, and in the subscription version, renewing 
your subscription when it falls due. Reckon may also verify subscription 
customers during a subscription period and not only at renewal. You 
will also need to reactivate your Software if you want to reinstall it (for 
example, if you upgrade your computer or if you have a hard drive 
failure, and you may incur a technical support cost for this).

•	 when you purchase the Software or during the course of your 
subscription you will be provided with an installation key code. Please 
keep the installation key code in a safe place. You will need it when you 
first install the Software and to reactivate the Software. Please note if 
you lose your installation key code that it will not be replaced by Reckon 
and you may be required to purchase new software.
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•	 You also need a registration key code to reactivate your Software. In 
addition, with some older versions of the Software, you may not be able 
to reactivate the Software if you do not have your installation key code 
– see details below on Reckon’s sunset policy.

•	 there will be no charge to activate the Software initially or to reactivate 
your Software when you verify your licence details or renew a 
subscription, unless you have lost your registration key code. Reckon 
may charge you a fee for technical support if it needs to reissue a 
registration key code provided also that the version of the Software 
you are using has not been “sunsetted” as explained below. Reckon 
may also charge a fee if you need to reactivate the Software in other 
circumstances (for example, if you need to reinstall the Software if you 
upgrade your computer or due to a hard drive failure).

•	 if you do not verify your licence details or renew your subscription (as 
applicable) within the required period, the Software may continue to 
operate but with impaired functionality or you may not be able to access 
the Software at all (including printing out or viewing any of your data or 
records).

•	 Reckon has a “sunset policy” which means that technical support is 
not available for some older versions of the Software. This includes the 
ability to reactivate that Software if you have lost your registration key 
code for those old versions. If you wish to continue using the Software 
in those circumstances, you will need to purchase a new copy of the 
current version of that Software. 

1.	 LICENCE

(a)	 Evaluation licence: IIf Reckon has provided a Trial Version of the 
Software to you, your rights to use the Trial Version are solely as set out in 
clause 10.

(b)	 Licence to use: Reckon grants you a personal, non-exclusive, non-
transferable, limited licence to use the Software on the terms of this 
Licence for the period determined in accordance with clause 8.

(c)	 No transfer of copyright: The Software is licensed not sold, despite 
any reference to “purchase” or “sale” in this Licence or in any invoice 
or purchase order for the supply of the Software. Reckon reserves all 
rights not expressly granted to you. Intuit Inc. is the owner of copyright 
in the Software and retains ownership of the copyright and all other 
intellectual property rights in the Software and is protected by copyright 
law and international copyright treaty.

2.	 YOUR PERMITTED USE OF THE SOFTWARE

(a)	 Single use licence: If you have purchased a single user licence, you:

	 (i)	� may install the Software once, on one computer only. However, if you 
wish to reinstall the Software (for example, if you need to install the 
Software on a replacement computer), then clause 3 will apply; and 

	 (ii)	� must ensure that the Software is used by one person only at any 
one time. 

(b)	 Additional licences: If:

	 (i)	 more than one person is to use the Software at the same time, or

	 (ii)	 the Software is to be installed on more than one computer

	 then you must obtain an additional licence for each additional person or 
computer. 

(c)	 QuickBooks Premier – Not applicable to Personal, Personal Plus 
and Home and Business

	 If you have purchased QuickBooks Premier, this Licence entitles you 
to load the Software on up to five computers (for use by a single 
processing unit only on each computer) for use by up to five individuals 
simultaneously. If you wish to install the Software on more than five 
computers you must obtain additional licences but for simultaneous 
access you will need to upgrade to an appropriate version that permits 
more than five users to simultaneously access a data file.

(d)	 QuickBooks Enterprise – Not applicable to Personal, Personal 
Plus and Home and Business

	 (i)	� if you have purchased QuickBooks Enterprise, this Licence entitles 
you to load the Software on up to ten computers (for use by a 
single processing unit only on each computer) for use by up to ten 
individuals simultaneously. You may not load the Software onto any 
further computers. 

	 (ii)	� if you have purchased QuickBooks Enterprise Accountants edition, 
this Licence entitles you to load the Software onto one computer 
(for use by a single processing unit). You may not load the Software 
onto any further computers.

(e)	 General restrictions: You must not:

	 (i)	� use or rely upon the Software for any purpose or in any manner for 
which the Software is not warranted.

	 (ii)	� copy, reproduce, translate, adapt, vary, merge or modify or create 
any derivative work based on the Software.

	 (iii)	� reverse engineer, decompile, disassemble, reconfigure or otherwise 
attempt to discover the source code of the Software.

Licence Agreement (cont)
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	 (iv)	� sell, market, network, transfer, lease, license, sub-license, rent, lend or 
otherwise dispose of or distribute the Software or use the Software to 
provide a bureau service.

(f)	 Licence verification: Upon written request from Reckon, including by 
email, you agree to provide Reckon with a signed certificate:

	 (i)	� verifying that the Software is being used fully in accordance with this 
Licence, including user and machine limitations, and 

	 (ii)	� listing locations, types and serial numbers of equipment on which 
the Software is run. 

	 You agree to allow Reckon to use and disclose any personal details 
provided to Reckon in connection with this Licence in accordance with 
Reckon’s then current privacy policy displayed on Reckon’s website.

(g)	 Audit rights: Reckon may also audit the number of copies of the 
Software in use or possession by you, the equipment on which the 
Software is installed or used and the number of users using the Software. 
Audits will be conducted in your normal business hours, or upon 
reasonable prior written notice, at Reckon’s expense. If the audit reveals 
underpaid or unpaid fees due to Reckon, you will be invoiced for them 
based on Reckon’s then current price list, and if these exceed 5% of the 
licence fees you have already paid, you will also be invoiced for the cost of 
the audit.

3.	 PRODUCT ACTIVATION AND VERIFICATION 

(a)	 Initial registration and verifying licence details: This Software 
may contain technology that protects Reckon against illegal copying. As a 
consequence, you may be required to:

	 (i)	� register your details during the initial installation (including your name, 
contact details and details of the hardware on which the Software will 
be installed (if this is not done automatically by the Software)

	 (ii)	� if you have a full version, have the Software reactivated periodically 
thereafter by verifying your licence details to confirm you are using 
the Software in accordance with these Licence terms

	 (iii)	� if you have a subscription version, have the Software reactivated 
(on payment of Reckon’s renewal fee and verification of your licence 
details) if you wish to renew the subscription

	 (iv)	� have the Software reactivated by Reckon if you wish to reinstall the 
Software (for example, if you would like to install the Software on a 
new computer or if you have a hard drive failure and need to reload 
your Software), and

	 (v)	� provide to Reckon the details of your installation key code and 
registration key code for the Software as part of the reactivation 
process. 
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	 You agree to register or reactivate the Software within a reasonable time or 
within such time as the Software prompts you to do so.

(b)	 Key codes: Each copy of the Software is provided with a unique 
installation key code (which may appear on the packaging or the cover 
of the media on which the Software is contained). You should keep the 
installation key code safe. As per clause 3(a)(v), you will be required to 
provide your installation key code to Reckon when you reactivate your 
Software. 

(c)	 Manner of verification: You must verify your licence details in the 
manner required by Reckon from time to time (which may include email or 
online registration via the Internet). The Software may prompt you as to the 
required manner of verification.

(d)	 Charges for reactivation: Reckon will not charge you to activate 
the Software initially or to reactivate your Software when you verify 
your licence details or renew a subscription, unless you have lost your 
installation or registration key code. You need both your installation code 
and your registration key code to be able to reactivate the Software. 
Reckon may charge you a fee for technical support to reissue a registration 
key code. Reckon may also charge a fee for technical support if you need 
to reactivate the Software in other circumstances (for example, if you need 
to reinstall the Software because you have a new computer or need to 
reload the Software due to a hard drive failure). For the current fees go to 
http://www.quicken.com.au. If you have lost your installation key code, 
Reckon will not replace that code, and you may be required to purchase 
new software.

(e)	 Consequences of non-renewal and failure to verify details: This 
Software is provided to you on the understanding and acknowledgment 
that it may contain technology which deactivates and disables the 
Software if a subscription is not renewed or, in the case of a full licence 
version, you have not verified your licence details when periodically 
prompted to do so by Reckon or by the Software. If the Software is not 
reactivated within the required period, the Software may continue to 
operate but with impaired functionality or you may not be able to access 
the Software at all (including printing out or viewing any of your data or 
records).

(f)	 Statutory declaration: In certain circumstances, before permitting a 
reactivation, Reckon may require you to provide a Statutory Declaration 
stating the reasons for reactivation.

(g)	 Older versions: Reckon has a sunset policy (covered in more detail in 
clause 4(a)) which means that technical support is not available for certain 
older versions of the Software. If technical support is not available for your 
version, you will not be able to reactivate or reinstall your Software if you 
do not have your registration key code. Reckon will not be obliged to 
provide you with a replacement key code and in those circumstances you 
will need to purchase a new version or Upgrade in order to continue using 
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the Software. Please go to http://www.quicken.com.au to see the sunset 
policy. 

4.	 TECHNICAL SUPPORT 

(a)	 Period when technical support is available: Reckon will provide 
technical support for the Software, during the following periods: 

	 (i)	� in the case of a subscription version of the Software, during the period 
for which you have paid the relevant subscription fees (unless further 
releases of the Software in question are discontinued), and

	 (ii)	� in the case of a full version of the Software, there is a “sunset 
period” during which technical support may not be available for that 
version. The sunset period for a version will commence on the earlier 
of:

		  (A)	� two years after the date on which you first installed the version on 
your computer, and

		  (B)	� the date Reckon releases the second successive Upgrade to 
that version.

	 For further explanation of Reckon’s sunset policy, please go to http://www.
quicken.com.au.

(b)	 What is included as part of technical support: Reckon will provide 
technical support in accordance with its then current technical support 
policy, which may include:

	 (i)	� as contemplated by clause 3, the technical support required to 
reactivate the Software or to issue a replacement registration key code 
(for example, when you verify your licence details, renew a subscription 
or if you need to reinstall the Software)

	 (ii)	 provision of telephone help desk support services

	 (iii)	� access to technical information about the Software contained on 
Reckon’s Web site, and

	 (iv)	 the ability for you to download Updates but it does not include provision 
of Upgrades of the Software. For further explanation of Reckon’s technical 
support policy please go to http://www.quicken.com.au. 

(c)	 Fees: Clause 3(d) sets out the circumstances when you will (and when you 
will not) be required to pay charges for the technical support to reactivate 
your Software (including when you wish to reinstall the Software) or for 
Reckon to issue a replacement installation key code. 

	 For all other technical support, Reckon may charge you a fee in 
accordance with its then current technical support policy.

5.	 ONLINE SERVICES

(a)	 Interaction with Online Services: The Software may contain access 
to, or features that interface with, online services (“Online Services”). 
Examples of Online Services that may be applicable to the Software are 
an online share price download facility, a statement download facility, 
payment services, a superannuation choice facility, an online backup facility 

Licence Agreement (cont)

and a debt recovery facility which are provided at an additional charge on 
a subscription basis measured for one year from the date of registration. 

(b)	 Terms for Online Services: Certain Online Services are not available 
for all versions of the Software. For example, in the case of bank statement 
download services, not all banks provide services that connect to the 
Software. Online Services are only available for 12-month periods for 
subscription versions and 24-month periods for full versions. In the case 
of a full version, access to Online Services in the second 12-month period 
may be subject to payment of the applicable charges. In order to renew 
access to Online Services at the end of the 24-month period in the case 
of a full version, you will be required to have purchased or upgraded to 
the latest version of the Software. In the case of a subscription version, 
you must have renewed your subscription. Internet access is required for 
all Online Services. Charges may apply for the use of Online Services (in 
addition to the cost of Internet access levied by your ISP). Where Online 
Services are available, separate terms and conditions with the provider of 
the Online Services may apply. You should check with the relevant third 
party provider as to the terms and conditions of use. Access to Online 
Services may be withdrawn by Reckon at any time. Reckon will not be liable 
for the withdrawal of access to any Online Services. Where access is to be 
withdrawn, Reckon may choose to notify you in advance provided that you 
have supplied Reckon with a valid and up to date email address. 

6.	 LIMITED WARRANTY

(a)	 Software provided on an “as is” basis: Subject to clause 7(b), 
Reckon provides the Software to you on an “as is” basis and without any 
representations by Reckon or any of its distributors regarding the use, 
performance or results of the use, of the Software.

(b)	 Defects in media: Reckon warrants that the media on which the 
Software is recorded is free from defects in manufacture for a period of 90 
days from the date of delivery. During this period, if you return the Software 
to your place of purchase, Reckon will replace any defective media on 
which the Software was supplied and any Software on that media, free of 
charge, unless you caused damage to the media due to poor handling.

(c)	 No guarantee that error free or uninterrupted use: While Reckon 
has endeavoured to make sure that the Software works substantially as per 
the specifications published by Reckon from time to time, Reckon does not 
guarantee that the Software will work on all computer hardware platforms 
or configurations and makes no warranty that the Software will be error 
free, that its use will be uninterrupted or be fit for your purpose.

(d)	 Internet access, telecommunications networks, third party 
applications, firewalls and security: Reckon does not guarantee 
connections to its online activation server or Online Services as these may 
be dependent upon third party networks and security measures over 
which Reckon has no control. Reckon also does not guarantee the accuracy 
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or validity of third party products such as for example superannuation 
calculators or similar applications. 

(e)	 Nothing in the Software is financial product advice and you should 
consider your own investment objectives, financial situation and 
particular needs before acting upon any information that you derive from 
the Software or third party products.

7.	 LIABILITY

(a)	 Certain rights cannot be excluded: The Trade Practices Act, 1974 and 
other laws may imply certain conditions and warranties into this Licence 
and give you certain rights and remedies that cannot be excluded or 
modified. This clause 7, and the limited warranties provided in clause 6, do 
not exclude or modify any of those rights if to do so would contravene that 
law or make any part of this Licence void.

(b)	 Exclusion of warranties: To the full extent permitted by law, Reckon 
excludes all conditions, warranties and rights that may be implied into this 
Licence. If conditions, warranties or other rights for your benefit are implied 
in this Licence or otherwise conferred by law and it is not lawful to exclude, 
restrict or modify them, then those conditions, warranties and other rights 
will (but only to the extent required by law) apply to this Licence. 

(c)	 Limitation of implied terms: Reckon’s (and its distributors’) liability for 
breach of any implied conditions or warranties that cannot be excluded 
is limited, to the extent permitted by law and at the option of Reckon, to 
replacing or re-supplying the goods or services or their equivalent again or 
the payment of the cost of having the goods or services or their equivalent 
replaced or supplied again.

(d)	 General exclusion and limitation: Other than as set out in clauses 7(b) 
and 7(c), and to the full extent permitted by law:

	 (i)	� Reckon (and its distributors) will not be liable to you or any other 
person for any direct or indirect loss, damages, liability, costs or 
expenses suffered by you or any other person relating to the 
performance or non-performance of the Software or any breach of 
this Licence or the supply of the Software or in connection with, but 
not limited to, the Online Services, use of tax tables or provision of 
technical support (whether by telephone or remote access or other 
means), and

	 (ii)	� Reckon’s maximum liability for damages arising in connection with 
this Licence or the supply of the Software is limited to the amount 
paid by you for the Software.

(e)	 Your liability to Reckon: You agree that Reckon (and its distributors) 
will not be liable, other than as expressly set out in this Licence, and that 
you will indemnify the Reckon (and its authorised distributors) from any 
liability, loss, damage, costs or expenses which you may suffer or incur as a 
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result of your use of the Software (including any claims made against you 
by third parties).

(f)	 Use of Software is not provision of professional advice: The 
information contained in this Software may contain features designed to 
assist you in complying with the requirements of the relevant legislation, 
eg: imposing the Goods and Services Tax (the “GST”) or the equivalent 
in the user’s home country. These features in the Software have been 
developed with regard to the GST laws and regulations and guidelines 
provided by the Australian Taxation Office (the “GST Laws”) as at the date 
of development of the Software (or the user’s home country tax office) (the 
“GST Laws”). The GST Laws are subject to change and the Software may not 
be correct at the date upon which you make use of the Software. While the 
features will assist in GST calculations, Reckon does not warrant that the 
Australian Taxation Office or the user’s home country tax office will agree 
with such calculations. The help contained in this Software is not 
a substitute for professional advice. The GST, Tax and other 
Laws are extremely complex in nature and legal and accounting 
advice should be obtained before taking any action in reliance 
on this Software. The software is also not financial product advice. If 
the Software contains features to assist with superannuation guarantee 
requirements, then Reckon does not warrant that the relevant reports will 
be compliant with legal requirements, as these change from time to time. 
In addition any tax tables (which are included with certain versions of the 
Software, eg: QuickBooks and Payroll) that might be supplied with this 
Software are also changed from time to time and you should consult with 
your professional adviser before relying on the tax tables. Reckon does 
not warrant that the tax tables are up to date at your date of purchase. 
In providing you with the tax tables, Reckon is not engaged in rendering 
legal, accounting or other professional services. If legal advice or other 
expert assistance is required, you should seek the service of a competent 
professional. 

(g)	 Reckon has no responsibility for recommendations: Reckon, its 
employees, agents, contractors and the authors disclaim any and all liability 
and responsibility to any person, whether a user of this Software or not, in 
respect of anything (including, without limitation, any error in or omission 
from this Software) and of the consequences of any actions taken or 
omitted to be taken in reliance, whether wholly or partially, upon all or any 
part of the content, recommendations or help contained in this Software.

(h)	 Corruption of data and online access: To the full extent permitted 
by law, Reckon and its distributors disclaim all liability for any corruption of 
data, inability to access data, loss of data, breach of privacy, or downtime as 
a result of or arising from the use of any online link available between the 
Software and another server including without limitation in connection 
with any Online Services.
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	 (i)	� Online Services: Reckon makes no warranty or representation in 
connection with the Online Services, the responsibility for which rests 
with the relevant provider of such Online Services.

8.	 TERM AND TERMINATION OF LICENCE

(a)	 Licence Term: Unless this Licence is terminated earlier in accordance 
with its terms, your right to use the Software in accordance with this 
Licence continues:

	 (i)	� in the case of a subscription version of the Software, for an initial 
period of 12 months from the date of registration of the Software. 
This Licence will automatically renew for a further 12 month period 
upon the payment of Reckon’s annual subscription fee. If the annual 
subscription fee is not paid on or before the termination of the current 
12 month period, this Licence will automatically terminate, and

	 (ii)	 in the full version of the Software, indefinitely, however:

		  (A)	� you may be required to periodically verify your licence details and 
have the Software reactivated as per clause 3 in order to keep using 
the Software, and

		  (B)	� if you need to reinstall the Software, you will need a copy of your 
original CD (or other media on which the Software was provided) 
and the installation key code. If you do not have the CD, you will 
need to purchase or upgrade to a new full version and pay for 
the postage associated with sending the CD to you.  Clauses 
3(d) and 3(g) outline when Reckon may charge you a fee for 
the provision of a replacement key code and, more importantly, 
when a replacement key code will not be provided by Reckon 
due to the operation of Reckon’s sunset policy.

(b)	 Termination by Reckon for breach: Reckon may terminate this 
Licence if you are in breach of its terms or as otherwise set out in this 
Licence.

(c)	 Survival: Clauses 2, 4, 6, 7 and this clause 8 will survive the termination of 
this Licence. Termination of this Licence will not prejudice any right which 
Reckon may have, or but for the termination may have had, against you for 
a breach of this Licence.

(d)	 Things you must do on termination: Upon the termination of this 
Licence, you or your representative must promptly uninstall the Software 
from your computer, destroy the CD, User Guide and related materials 
and any copies of them in your possession or control or return or dispose 
of them in the manner directed by Reckon. Upon written request from 
Reckon you agree to provide a Statutory Declaration to Reckon that you 
have complied with your obligations under this clause 8(d).

9.	 SUBSCRIPTION TERMS

	 If you have purchased a subscription version of the Software, this additional 
clause 9 will apply.
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(a)	 Entitlement to Upgrades and Updates: During the period for which 
you have paid subscription fees you will receive, included in the cost of 
the subscription, all Upgrades and/or Updates of the Software, via Internet 
download. 

(b)	 No extension of Licence term: Your right and entitlement to use 
the Software, as enhanced by any Upgrades and/or Updates, concludes 
at the end of the term of the Licence (subject to payment of an annual 
subscription fee) and is not linked to the dates of release, registration or 
provision by Reckon of any Upgrades and/or Updates. 

(c)	 This Licence prevails: If you have bought this Software as an Upgrade 
to an earlier version of the Software, this Licence shall supersede any 
previous licence agreement. 

(d)	 Not all Upgrades included: Your subscription to the Software and any 
Upgrades and/or Updates under this Licence does not grant you the right 
to receive special versions of the Software created for certain customers 
or market segments, even though they may contain similar features or 
functions. Versions of the Software which may from time to time be offered 
in retail or other channels in different configurations as special promotions 
are not included as part of the subscription. 

(e)	 No obligation on Reckon to upgrade: Upgrades and/or Updates will 
be developed and released by Reckon in its sole discretion, and Reckon 
does not warrant or represent that it will develop or release any Upgrades 
and/or Updates during the term of the subscription period or Licence. 
Furthermore, Reckon does not warrant that the Upgrades and/or Updates 
will be provided to you or made available within any specified time period 
following the commercial release of such Upgrades and/or Updates. 

(f)	 When payment is due: If applicable to the Software licensed to you, 
you will be required to pay the monthly subscription fee in advance on the 
first business day of each month. You authorise Reckon to direct debit your 
monthly subscription fee from the bank account nominated by you. 

(g)	 Deactivation at end of subscription period: As per clause 3, 
the subscription version of the Software is provided to you on the 
understanding and acknowledgment that it may contain technology 
which deactivates and disables the software if your subscription is not 
renewed or you are found to be in breach of this licence agreement. If the 
Software is not renewed by the end of the required period, the Software 
may continue to operate but with impaired functionality or you may not be 
able to access the Software at all (including printing out or viewing any of 
your data or records).

(h)	 You need a full version if you don’t renew: If you elect not to renew 
your subscription, the Software does not allow you to upgrade to a non-
subscription version of the Software by way of the purchase of an Upgrade 
pack. In such circumstances, you are only able to upgrade to a later non-
subscription version of the Software by purchasing a full (non-upgrade) 
version of the Software.
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(i)	 Early termination: If you wish to terminate your subscription early, you 
must do so by giving Reckon no less than one calendar month notice to 
that effect. Depending on the type of software you have subscribed to and 
the type of subscription you are signed up for, you may be required to pay 
a cancellation fee. See http://www.quicken.com.au for a schedule of fees. 
Reckon will direct debit your account, and you agree to pay, the applicable 
cancellation fee.

10.	 TRIAL LICENCE

	 If you have been provided with a Trial Version of the Software, this clause 
10 sets out the terms that will apply to your use of the Trial Version.

(a)	 Licence: Your licence to use the Trial Version:

	 (i)	� is for up to two uses of the Software and you are then required to 
register your use of the Trial Version and then you will have another 
ninety days to evaluate the Software (Evaluation Period).

	 (ii)	� permits you to evaluate the Software’s functionality and suitability for 
your requirements

	 (iii)	� is for the number of users set out in the material accompanying your 
copy of the Trial Version, and

	 (iv)	� is subject to the general restrictions in clause 2(e) and the limited 
warranty in clause 6(a). 

(b)	 Duration: You acknowledge that your licence to use the Trial Version will 
only apply for the Evaluation Period. At the end of the Evaluation Period:

	 (i)	� you must not and will not be able to continue to access the Trial 
Version, including any data that you have entered into the Trial Version, 
and

	 (ii)	� if you wish to use the Software you must purchase a full version or 
subscription version of the Software. 

(c)	 Entitlements: You:

	 (i)	� are not entitled to Upgrades or Updates (or any other software other 
than the Trial Version), and

	 (ii)	� may be required to pay for any technical support that you may 
require in relation to the Trial Version in accordance with Reckon’s 
then current charges.

(d)	 Liability: You acknowledge that [subject to clause 7(b) and 7(c), and to 
the full extent permitted by law, Reckon excludes all liability to you for any 
loss, damage, liability, costs or expenses suffered by you relating to the 
performance or non-performance of the Trial Version or any breach of this 
clause 10.

11.	 GENERAL

Your unique Installation Key Code and CD are extremely 
valuable and may be required to reactivate or reinstall the 
software. Please keep the code in a safe place with your 
CD. If you lose your Installation Key Code or CD, they 
will be replaced only while this version is supported and 
administrative charges may apply.

(a)	 Some defined terms: In this Licence:

	 Trial Version means Software that has been provided to you on a 
temporary basis in  order to carry out a trial of that Software to determine 
whether you wish  to use the Software on an ongoing basis.

	 Upgrade means a new version of the Software which contains additional 
functionality or other enhancements.  Reckon will determine whether a 
new version constitutes an Upgrade or an Update.

	 Update means a new version of the Software which contains minor 	
enhancements. 

(b)	 Applicable law: This Licence is governed by the laws of the State  
of New South Wales, Australia.

(c)	 Entire Agreement: This Licence contains the entire agreement between 
Reckon and you in relation to its subject matter and supersedes any prior 
agreements and understandings, whether written or oral.

(d)	 Waiver: Any failure to enforce any rights under this Licence by Reckon is 
not to be taken as a waiver of those rights.

(e)	 Variation: To the extent permitted by law, Reckon may vary any of the 
terms and conditions of this Licence upon providing you with thirty (30) 
days notice in writing and a copy of the replacement terms and conditions. 
In the case of subscription users no new terms will come into force until the 
commencement of your renewed subscription period. Reckon will display 
any new terms and conditions on Reckon’s web site and you should check 
the website regularly. 

(f)	 Headings: Clause headings are for ease of reference only and do not 
affect the meaning of this Licence.

Quicken and QuickBooks are registered trademarks of Intuit Inc.

Copyright© 1985-2007 Intuit Inc, 2006-2007 Reckon Ltd.
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Customer ID:

Customer PIN:

Installation Key Code:

Installation
Computer/
User

Product Key Licence Key

Example Reception
X7F6h2P9-
9DN4H2T4-
S4F7H3D1

A43DG4Y1- 
H6J3F1H3- 
BV65G2F4

PC 1 

PC 2

PC 3

PC 4

PC 5

You will need these numbers for re-registration purposes. 
Please have these details on hand when contacting Quicken. 

You can find these details in Quicken by going to Help menu 
> My Licence Information

My original CD is safely stored here:

(describe location or contact person)

Your important reference 
numbers

Asia
Technical support is available Monday to Friday, from 
9.00am – 5.00pm at US$40 per incident support.

	� Singapore +65-6254-2322  
Philippines +63(2) 531 2443 or +63(2) 746 4669

	 www.quicken-asia.com

ZUI15AGBG  HC9139

Contacting Quicken  
Technical Support

New Zealand
Technical support is available Monday to Friday,  
9.00am – 5.00pm NZ

	 Installation Support  + 64 9414 3650 
	� Per minute support 0900 33 609  

Calls cost – $4.95 /min (incl GST) 
Charges are higher from public and mobile phones. 
Call costs and operating hours are subject to change.

	 www.quicken.co.nz

Australia
For installation and software support. Technical Support is available 
Monday to Friday, 9.00am – 5.00pm AEST. Weekend support is also 
available, check Web site for operating hours. Extended hours are 
available to Quicken Advantage members.

	 �1902 223 101

	 Call costs - $4.90 /min (incl GST)

	� Charges are higher from public and mobile phones. 
Call costs and operating hours are subject to change.

	 www.quicken.com.au/support


